Izrada prvog crteza

U ovom PoGLAVLJU upoznadete neke od osnovnih funkcija programa AutoCAD. Imacete
priliku da veZbate u grafickom editoru. Crtacete jednostavan crteZ koji cete koristiti u
kasnijim vezbanjima. Naucicete kako da unosite podatke u AutoCAD, da tumacite zah-
teve za unos i da u slu¢aju potrebe trazite pomoc. Ovo poglavlje obuhvata i kori§cenje
koordinatnog sistema koji sluZi za precizno zadavanje dimenzija objektima u AutoCAD-u.
Videcete kako da izaberete objekte koje ste nacrtali i kako da zadate osnovne tacke za
pomeranje i kopiranje.

Ako niste pocetnik u AutoCAD-u, moZzda cete Zeleti da odmah predete na sloZenije
teme u poglavlju 3. Koristite datoteke s prateceg CD-a da biste nastavili obuku.

Obradene su sledece teme:

« Upoznavanje s paletom Draw

u Pocetak rada na prvom crtezu

v Zadavanje rastojanja pomocu koordinata
v Kursori razli¢itih oblika i zahtevi za unos
v Izbor objekata

v Pomo¢ tokom rada

u Ako Zelite da eksperimentisete...

Upoznavanje s paletom Draw

Prvi zadatak tokom obucavanja za crtanje u AutoCAD-u jeste da nacrtate liniju (duZ).
Pre nego $to poc¢nete crtati, zadrZacemo se za trenutak na paleti alatki koja se koristi viSe
od svih ostalih — paleti Draw.

1. Pokrenite AutoCAD kao $to ste radili u prvom poglavlju - pritisnite Start > All Pro-
grams > Autodesk > AutoCAD 2004 > AutoCAD 2004. Ako se otvori okvir za dija-
log Startup, pritisnite Cancel i podrazumevano ce se otvoriti dokument Drawing]1.
Kasnije u ovom poglavlju naucicete vise o ovom okviru za dijalog.
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2. U prozoru AutoCAD postavite kursor na ikonicu na vrhu palete Draw (to je verti-
kalna paleta uz levu ivicu prozora AutoCAD) i zadrZite ga na tom mestu dok se ne
pojavi ime alatke.

3. Polako pomerajte kursor nadole preko ostalih alatki palete Draw i procitajte
kratak opis svake od njih.

U vecdini slucajeva prepoznacete funkciju svake alatke ve¢ po izgledu njene ikonice.
Slicica liika, recimo, govori da se alatka koristi za crtanje lukova; slicica elipse govori da
alatka sluzi za crtanje elipsa itd. Samo ime alatke bolje ¢e objasniti njenu funkciju. Osim
toga, statusna traka na dnu prozora AutoCAD daje obavesStenja o alatkama. Na primer,
ako pokaZete alatku Multiline Text na dnu palete Draw, na statusnoj traci moci cete da
procitate objasnjenje Creates a multiple-line text object (Pravi okvir za unos
viserednog teksta). Ovo vam takode govori ime komande: MTEXT. Da biste pokrenuli ovu
alatku, upisite ime komande: MTEXT u komandni prozor. Ukoliko piSete makro ili pra-
vite svoje alatke, koristite MTEXT.
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Tabela 2.1 pomo¢i ¢e vam u radu s dve osnovne palete, Draw i Modify. Tokom ucenja
uz ovu knjigu, imacete priliku da isprobate mnoge AutoCAD-ove alatke.

Tabela 2.1: ALATKE S PALETA DRAW | MODIFY | NJIHOVE POTPALETE

PALETA DRAW
IKONICA ALATKA

eRNmEENN

Line - linija (duz)

Construction Line (Xline) — prava
Polyline (Pline) - sloZena linija
(polilinija)

Polygon - poligon

Rectangle — pravougaonik

Arc - ldk

Circle - krug
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ALATKA
Erase — brisanje

Copy Object - kopiranje objekata
Mirror — preslikavanje

Offset — paralelno kopiranje
objekata

Array — videstruko kopiranje
objekata (matrica)

Move - translatorno pomeranje
objekata

Rotate - rotiranje objekata



UPOZNAVANIJE S PALETOM DRAW

Tabela 2.1: ALATKE S PALETA DRAW | MODIFY | NJIHOVE POTPALETE (NASTAVAK)
PALETA DRAW
IKONICA ALATKA

]
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Revcloud - zatvorena sloZena
linija sastavljena od jednakih
lu¢nih segmenata koji formiraju
oblak. Omogucava obelezavanje
delova crteza (novo u odnosu
na verziju 2002)

Spline - sloZena linija tipa spline
(krive viSeg reda)

Ellipse — elipsa

Ellipse Arc- elipticni Idk

Insert Block — umetanje blokova
Make Block — pravljenje blokova
Point — tacka

Hatch - Srafura

Region - oblast

Multiline Text — viSeredni tekst

PALETA MODIFY
IKONICA  ALATKA

Scale - linearno uvecanje
ili umanjenje objekata

Stretch - istezanje objekata

Trim — odsecanje objekata
Extend - produZavanje objekata

Break at Point — prekidanje
objekata u zadatoj tacki

Break - prekidanje objekata
Chamfer — obaranje ivica
Fillet - zaobljavanje ivica

Explode - rastavljanje sloZenih
objekata
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Kao $to ste naucili u poglavlju 1, pritiskanjem ikonice alatke aktivirate komandu.
Neke alatke moZete izabrati i vuci, ¢ime otvarate potpaletu na kojoj se nalaze dodatne
opcije te alatke. Ako alatka ima potpaletu, videcete mali trougao u donjem desnom uglu
ikonice alatke.

1. Pritisnite i povucite alatku Zoom Window, koja se nalazi na paleti Standard. Poja-

vljuje se potpaleta s nizom dodatnih alatki. Te alatke omogucavaju da podesite
prikaz na razli¢ite nacine.
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2. Pomerajte kursor niz potpaletu ka poslednjoj alatki sve dok ne vidite natpis Zoom
Extents, a zatim otpustite taster miSa. Umesto ikonice alatke Zoom Window sada
je tu ikonica koja predstavlja komandu Zoom Extents.
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Pritiskanjem ikonice alatke Zoom Extents aktivirate istoimenu komandu koja
podesava prikaz tako da elementi crteZa ispune prostor za crtanje. Posto crtez sada
ne sadrZi nijedan element, prikaz se nece promeniti. U poglavlju 3 upotrebicete
ovu komandu Zoom Extents i videti kako ona deluje na elemente crteza.

3. Da bi alatka Zoom Window ostala vidljiva na paleti Standard, pritisnite i povucite
ikonicu alatke Zoom Extents, a zatim izaberite ikonicu alatke Zoom Window, koja
se nalazi na vrhu potpalete. Pritisnite taster Esc da biste prekinuli komandu Zoom
Window (koju cete koristiti u poglavlju 3).

AutoCAD omogucava da brzo pristupite najcesce koriS¢enim komandama s potpa-
leta tako $to poslednju izabranu opciju smatra podrazumevanom. Ta osobina moZze da
zbunjuje pocetnike u AutoCAD-u. Isto tako, grupisanje opcija u potpaleti nije uvek
samo po sebi razumljivo, ¢ak ni iskusnima u radu sa AutoCAD-om.

SAVET  Ako se ispostavi da CeScée radite s nekom potpaletom, lako je moZete pretvoriti u
pokretnu paletu alatki da bi vam bila dostupna cim jednom pritisnete taster misa. Na primer,
potpaletu Zoom, koju ste malopre koristili, moZete otvoriti kao paletu alatki tako $to Cete
desnim tasterom misa pritisnuti bilo koju paletu alatki, a zatim iz prirucnog menija koji se
pojavi izabrati Zoom.

RAD S PALETAMA ALATKI

U sklopu veZbi iz knjige pokazacu vam graficke simbole alatki koje treba da izaberete, kao i
paletu i potpaletu koje sadrZe tu alatku. Nemojte se brinuti ako paleta alatki iz primera ne
izgleda isto kao paleta koju vidite na ekranu. Radi Stednje prostora na stranama, na nekim
mestima su slike paleta i potpaleta postavljene horizontalno; one koje vidite na ekranu mogu
biti postavljene vertikalno, poput paleta Draw i Modify, koje se nalaze na levoj, odnosno des-
noj strani prozora AutoCAD. Bez obzira na razli¢it oblik paleta i potpaleta na ekranu i u
knjizi, njihov sadrzaj je isti. Kada posmatrate graficki znak koji predstavlja alatku, vazno je da
obratite paznju na samu ikonicu s imenom alatke i na paletu u kojoj se ta alatka nalazi.

Pocetak rada na prvom crtezu

U poglavlju 1 videli ste uzorak crteza koji ste dobili uz AutoCAD. Samostalan rad pocecete
crtanjem vrata koja ée se koristiti i u kasnijim vezbama. Prvo morate nauciti kako da saop-
Stite AutoCAD-u ono §to Zelite i, §to je vaZnije, morate razumeti Sta AutoCAD trazi od vas.

SAVET U ovom poglavlju videcete uputstva i za engleski i za metricki sistem. Uglavnom ce

prvo biti data uputstva za engleski sistem, a posle njih i za metricki sistem. Medutim, jos se
necete baviti incima i centimetrima. Zasad se samo upoznajete sa sistemom AutoCAD-a.
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POCETAK RADA NA PRVOM CRTEZU

Pocnite tako Sto Cete otvoriti okvir za dijalog Create New Drawing. Ovaj okvir za dija-
log ¢e pomodi pocetniku pri brzom podeSavanju crteza.

1. Izaberite Tools > Options. Otvorice se okvir za dijalog Options.
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2. Pritisnite karticu System.

3. U grupi opcija General Options, pritisnite padajucu listu Startup i izaberite Show
Startup Dialog Box.

4. Pritisnite OK da biste potvrdili novo podeSavanje i izadite iz okvira za dijalog.

Biranjem opcije Show Startup Dialog Box, AutoCAD ¢e otvoriti okvir za dijalog Create
New Drawing kad god budete pocinjali nov crteZ. Ovaj okvir za dijalog koristicete na
pocetku poglavlja. Ako odlucite da vam nije potreban ¢arobnjak, posto ste se bolje upo-
znali sa AutoCAD-om, lako ga moZete iskljuciti ponavljajuci prethodne korake. Umesto da
izaberete Show Startup Dialog Box u koraku 3, izaberite Do Not Show A Startup Dialog.

NAPOMENA  Kada je ukljucena opcija Show Startup Dialog Box, okvir za dijalog Startup ce
se prikazivati i pri pokretanju AutoCAD-a. Okvir za dijalog Startup je vrlo slican kao okvir
New Drawing.

Napravimo sada novu datoteku.

1. Izaberite File > Close da biste zatvorili teku¢u datoteku. U okviru za dijalog Save
Changes izaberite No. Palete alatki nestaju i pojavljuje se AutoCAD-ov prozor za
crtanje koji je prazan, jer nijedan crtez nije otvoren.

2. Izaberite File > New. Pojavljuje se okvir za dijalog Create New Drawing.
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38 POGLAVLIE 2 IZRADA PRVOG CRTEZA

% 3. Pritisnite dugme Use A Wizard. U polju s listom Select a Wizard pojavljuju se dve
& nove opcije: Advanced Setup i Quick Setup.
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4. Izaberite opciju Quick Setup, a zatim pritisnite OK. Pojavljuje se okvir za dijalog
Quick Setup Units.

5. Zasad Cete koristiti standardne decimalne jedinice, kao $to je i naznaceno radio-
-dugmadima. O ovim opcijama bice vi§e reci u slede¢em poglavlju. Pritisnite Next
i pojavljuje se okvir za dijalog Quick Setup Area.

6. Dvaput pritisnite polje Width i, ako nije ve¢ upisan broj 13 upisite ga. Oni koji
koriste metricki sistem trebalo bi da unesu 40.

7. Pritisnite taster Tab da biste presli u polje za unos Length i upisite 9. Oni koji kori-
ste metricki sistem trebalo bi da unesu 30.

ACOA 1l 4 20N4 Q+*925E am



POCETAK RADA NA PRVOM CRTEZU 39

liln

F f=n

-|-|-|Fn-l-| |

8. Izaberite Finish. U AutoCAD-ovom prozoru pojavljuje se nova datoteka.

9. Izaberite View > Zoom > All s linije menija. Na taj nacin ¢ete zadati da prikaz
zauzme celokupan prostor koji ste definisali u koracima 61i 7.
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10. Izaberite File > Save As da biste svojoj novoj datoteci dali jedinstveno ime. Otvo-
rice se okvir za dijalog Save Drawing As.

11. Otkucajte Vrata. Dok kucate, ime se pojavljuje u polju File Name.

12. Dvaput pritisnite direktorijum Sample s glavne liste datoteka u okviru za dijalog
da biste otvorili poddirektorijum Sample.

13. Izaberite Save. Sada imate datoteku Vrata. dwg, koja se nalazi u poddirektori-

jumu Sample direktorijuma AutoCAD2004. Datoteka je jo$ prazna. Popunjava-
njem Cete se baviti kasnije.

Kada otvorite novu datoteku, pred vama se na ekranu nalazi povr§ina za crtanje,
Siroka otprilike 12 inca i visoka oko 9 in¢a (40 x 30mm, u metrickom sistemu). To je vasa
radna povrs$ina, mada niste ograni¢eni samo na nju. Nikakvi vidljivi podaci ne odreduju
veli¢inu te povrSine. Tacne dimenzije saznacete ako pomerite kursor do gornjeg desnog
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40 POGLAVLIE 2  IZRADA PRVOG CRTEZA

7]

ugla ekrana i procitate vrednost koja se pojavljuje u polju koordinata, u donjem levom
uglu prozora programa AutoCAD. To je standardna povr§ina AutoCAD-a za izradu novih
crteza.

UPOZORENJE  Pokazivac koordinata nece pokazivati tacno 12 % 9 inca, odnosno 40 x 30 mm,
zato $to proporcije povrsine za crtanje najverovatnije ne iznose tacno 12 x 9ili 40 x 30. Kada iza-
berete View > Zoom > All, AutoCAD ¢e pokusati da prilagodi prikaz vasoj povrsini za crtanje.
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Pratite sledece korake da biste zapoceli crtez:

1. Izaberite alatku Line s palete Draw ili otkucajte L.
Upravo ste zadali komandu Line. AutoCAD na to odgovara na dva nacina. Prvo
¢ete u komandnom prozoru ugledati poruku:
Specify first point: (zadajte prvu tacku)

koja trazi da izaberete pocCetnu tacku linije. Kursor je promenio oblik; krsti¢ vise
nema kvadrati¢ u centru. Na osnovu toga znate da treba izabrati jednu tacku za
pocetak linije.

SAVET  Radecdi vezbe iz ove knjige, moci Cete da koristite i precice s tastature da biste zadali
komande. Na primer, komandu Line zadajete i ako upisete L0 u komandnom prozoru.
2. Levim tasterom mi$a izaberite tacku u blizini centra ekrana. Naredna poruka glasi:

Specify next point or [Undo]: (zadajte slede¢u tacku ili [Poni-
Stite])

Dok pomerate kursor, prati ga linija koja je drugim krajem u¢vr§éena za odabranu
tacku (gornji crtez na slici 2.1). Takve linije nazivamo rastegljive (engl. rubber-
banding).
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SLIKA 2.1
Dve rastegljive
linije.

Prva tacka

Rastegljiva linija

Rastegljiva linija

Segment linije

Ako kursor pomerite levo ili desno od poloZaja koji je u visini izabrane tacke, uz
kursor ce se pojaviti horizontalna tackasta linija i poruka koja daje savet o alat-
kama. Isto se dogada i kada kursor pomerite vertikalno iznad ili ispod izabrane
tacke. U stvari, izgledace kao da kursor skace u horizontalni ili vertikalni poloZaj.

Podars 3 006 <0

Opisana osobina se naziva pracenje po polarnim koordinatama (engl. polar trac-
king). Ta opcija pomaze da liniju nacrtate ta¢no u horizontalnom ili vertikalnom
pravcu, kao kad crtate pomocu T-lenjira i trougla. MoZete da je ukljucite ili isklju-
Cite i to tako §to Cete pritisnuti dugme Polar na statusnoj traci. Ako je ne vidite,
najverovatnije je isklju¢ena. O ovoj opciji bice viSe reci u poglavlju 3.
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Iako u ovom poglavlju necete nauciti kako da koristite opciju Polar Tracking,

saznacete nesto o poruci koja se pojavljuje uz kursor kada je ova opcija aktivna.

Nastavimo rad s komandom Line.
3. Pomerite kursor do neke tacke ispod i desno od prve tacke koju ste izabrali i ponovo

pritisnite levi taster miSa. Prva rastegljiva linija sada je pri¢vr§¢ena izmedu dve
tacke koje ste izabrali i pojavljuje se druga rastegljiva linija (drugi crteZ na slici 2.1).

4. Liniju neodgovarajuce duzine moZete promeniti dok je komanda Line aktivna.

Izaberite Undo s palete Standard ili upisite UC.

Alatka Undo s palete Standard nudi padajucu listu Undo sa koje moZete izabrati

tacno onu komandu koju treba izbrisati. Pogledajte izdvojeni odeljak koji sledi, Kako da se
izvucete iz nevolje.

Linija koju ste prethodno nacrtali postaje ponovo rastegljiva, kao da uopste niste
bili izabrali drugu tacku i fiksirali njenu duzinu. Upravo ste nacrtali i obrisali liniju
proizvoljne duZzine. Komanda Line je jo§ uvek aktivna. To potvrduju dva pokaza-

telja: ne vidite re¢ Command na dnu komandnog prozora, a kursor je obi¢an krstic

SAVET
tion mode of the cursor). Na slici 2.7 videcete razlicite oblike kursora za crtanje.

bez malog kvadrata u centru.

Od sada cemo krsti¢ bez kvadratica zvati kursor za izbor tac¢aka (engl. point selec-

KKAKO DA SE 1ZVUCETE 1Z NEVOLJE

| pocetnici i iskusni korisnici ponekad greSe. Pre nego $to nacnemo ozbiljnije teme, nabro-
jacemo nekoliko mocnih alatki koje ¢e vam pomocdi ako se nadete u nevolji.

Backspace (~) Ako pogresite pri kucanju, tasterom Backspace obrisite gresku i ponovo
upisite komandu ili odgovor. Ovaj taster se nalazi u gornjem desnom uglu osnovnog dela
tastature.

Escape (Esc) Ovo je verovatno najvazniji taster na tastaturi. Kada treba brzo, bez ikakvih
izmena izaci iz komande ili iz okvira za dijalog, pritisnite taster Esc u gornjem levom uglu
tastature. U starijim verzijama programa AutoCAD, u nekim slucajevima trebalo je dvaput
pritisnuti taster Esc. Pocev od AutoCAD-a 2000, dovoljno je pritisnuti Esc samo jedanput, a
nece biti Stete ni ako ga pritisnete dvaput. (Pritisnite taster Esc pre nego $to pocnete da
menjate crteZ koristedi ¢vorove (engl. grips) ili da zadajete komande preko tastature.)

U0 Ako slucajno izmenite deo crteZa pa hocete to da ponistite, pritisnite alatku Undo s
palete Standard (ikonica sa strelicom savijenom ulevo). Isto tako, U0 moZete upisati i u
komandni prozor. Kad god to uradite, AutoCAD ponistava jednu po jednu operaciju i to
redosledom obrnutim od onog kojim ste ih izveli - poslednja zadata komanda ponistava
se prva, zatim pretposlednja itd. U komandnom prozoru se pojavljuje ime komande koja
se ponistava, a crtezu se vraca izgled koji je imao pre primene komande. Tako moZete
ponistiti sve Sto ste izmenili i crtezZu vratiti izgled s pocetka radne sesije.

Undol Ako odlucite da se vratite nekoliko koraka od operacije koju ste upravo izveli,
moZete upotrebiti alatku Undo (strelica savijena ulevo) s palete Standard ili otkucajte
Undoll. Svaki put kada pritisnete alatku Undo, vracdate se jednu operaciju unazad.
U AutoCAD-u 2004, mozete tacno izabrati komandu koju Zelite da izbriSete koristedi
padajucu listu Undo. Ovu listu moZete otvoriti pritiskanjem strelice nadole, koja se nalazi
desno od alatke Undo.
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ZADAVANJE RASTOJANJA POMOCU KOORDINATA
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Redold Ako komandom Undo slucajno ponistite previse prethodnih radnji, poslednju
ponistenu komandu moZete vratiti pomocu alatke Redo (strelica savijena udesno) s palete
Standard; ili upisite Redo. U AutoCAD-u 2004, Redo dozvoljava da vratite nekoliko oper-
acija koje ste mogli da izbriSete komandom Undo. Isto tako, moZete izabrati tacno onu
komandu koju hocete da vratite koristeci padajucu listu Redo. Da biste otvorili ovu listu,
pritisnite strelicu nadole koja se nalazi desno od alatke Redo.
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Zadavanje rastojanja pomocu koordinata

Nastavi¢emo rad s komandom Line i nacrtati ortogonalnu projekciju (pogled odozgo)
vrata proizvoljnih dimenzija. Kasnije Cete crtezu zadati prave dimenzije, potrebne za
naredne vezbe. Neka duzina vrata bude 3.0 jedinice, a debljina 0.15 jedinica.

U metrickom sistemu mera, duZina vrata bice 9 jedinica, a debljina 0.5 jedinica. Da biste
precizno zadali ove mere, u AutoCAD-u moZete koristiti relativni polarni ili relativni
Dekartov koordinatni sistem.

UPOZORENJE U vezbama u ovom poglavlju vrednosti engleskih i metrickih jedinica nisu
ekvivalentne. Na primer, 3 jedinice na crtezu radenom u engleskom sistemu mera nije isto sto i
9 jedinica u metrickom sistemu. Te vrednosti su proizvoljne, a koje ce biti zadate zavisi od toga
kako Cce izgledati na slikama u ovom poglavlju.

Zadavanje polarnih koordinata
Da biste nacrtali liniju duZine tri jedinice (odnosno, 9 u metrickom sistemu) nadesno od
poslednje zadate tacke, uradite sledece:
1. Otkucajte @3<0. Oni koji koriste metricki sistem neka upisu @9<0. Dok kucate,
slova se pojavljuju u komandnom prozoru.

2. Pritisnite U. Pojavljuje se linija koja pocinje od prve odabrane tacke i zavr§ava se
tri jedinice dalje udesno (slika 2.2). Upravo ste zadali relativne koordinate u polar-
nom koordinatnom sistemu.
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SLIKA 2.2
Obratite paznju,
rastegljive liniije
sada pocinju od
poslednje iza-
brane tacke.

To govori da

|
moZete dodavati \
jos linijskih Rastegljiva
segmenata.

linija

Segment linije

dug 3 jedinice,
odnosno 9 jedinica

u metrickom sistemu

Znak ,et“ (@) obavestava AutoCAD da se rastojanje koje ste naveli racuna relativno
od poslednje izabrane tacke. Broj 3 (ili 9 u metrickom sistemu) oznac¢ava duZinu, a znak
»manje od“ (<) obavestava AutoCAD o uglu pod kojim crtate liniju. Poslednji broj je veli-
¢ina ugla, u ovom slucaju 0. Na taj nac¢in AutoCAD-u saopStavate duzinu i smer linije u
relativnom polarnom koordinatnom sistemu.

SAVET  Ako ste navikli da na neki drugi nacin oznacavate nulti smer, AutoCAD moZete pri-
lagoditi tako da koristi vertikalni smer ili smer nadole za nulti. Detalje potraZite u poglavlju 3.

Uglovi su dati kao $to je prikazano na slici 2.3, gde 0 stepeni oznacava horizontalni
smer sleva nadesno, 90 stepeni je pravo nagore, 180 stepeni je horizontala zdesna
nalevo itd. MoZete da zadate stepene, minute i sekunde ltika ako je takva preciznost
potrebna. Formate jedinica za uglove obradi¢emo detaljnije u poglavlju 3.

SLIKA 2.3 90°
AutoCAD-ov
standardni sistem 135° o
za definisanje pi
uglova.
180° 0°
225° 315°
270°
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SLIKA 2.4

Ove tri strane
vrata nacrtane su
alatkom Line.

pomocu relativ-
nih Dekartovih
koordinata, ili

nih koordinata.

ZADAVANJE RASTOJANJA POMOCU KOORDINATA

Zadavanje relativnih Dekartovih koordinata

Nacrtajmo sledecu liniju pomocu druge metode preciznog definisanja duZine.

1. UpiSite @0,0.150. Za metricki sistem, upisite @0,0.501. Pojavljuje se kratka linija
iznad krajnje tacke prethodne linije.

SAVET U ovom odeljku je naznaceno da bi oni koji koriste metricki sistem mera trebalo da
unesu @0,0.50 za duZinu. MoZete uneti i 0,.5. Nula na prvom mestu stoji radi jasnoce. Oni koji
koriste evropski metricki sistem trebalo bi da znaju da se zarez koristi da razdvoji x i y koordi-
natu. Zarez se ne upotrebljava za decimale. U AutoCAD-u se decimale razdvajaju tackom.

Kao i malopre, znak @ obavestava AutoCAD da se navedena duZina meri relativno
u odnosu na poslednju tacku. U ovom primeru duZzinu zadajemo kao x iy vredno-
sti. Zadata je prvo vrednost duzine za x, 0, odvojena zarezom, a zatim vrednost
duzine za y, 0.15. Na taj nacin se definiSu duzine u relativnom Dekartovom koor-
dinatnom sistemu.

2. Upisite @-3,00 (@-9,00). Rezultat je crtez kao na slici 2.4.

Rastegljiva linija

1
Tacke su zadate ] bl
= |

relativnih polar- ——

DuZina koju ste uneli u koraku 2 bila je iskazana vrednostima x,y, ali ovde ste kori-
stili negativnu vrednost za zadavanje duZine x. Pozitivne vrednosti u Dekartovom
koordinatnom sistemu odreduju pravac linije sleva nadesno i odozdo nagore
(slika 2.5). (Ovog se moZda secate sa ¢asova geometrije iz srednje 8kole!) Ukoliko
Zelite da nacrtate liniju zdesna nalevo, morate uneti negativan predznak. Takode
je korisno znati gde se nalazi pocetna tacka na crtezu. Na novom crtezu, pocetak,
tj. koordinata 0,0, nalazi se u donjem levom uglu crteza.

SAVET  Crtanje niza linija moZete zavrsiti, a da ne zatvorite konturu; pritisnite Esc, O ili
razmaknicu (taster za razmak).

3. Otkucajte CL. C oznacava opciju Close kojom se zatvara niz linija. Nacrtali ste
liniju koja povezuje prvu i poslednju tacku niza linija i zavrsili crtanje komandom
Line (slika 2.6). Nestaje i rastegljiva linija, Sto govori da je AutoCAD zavrsio crtanje
linija. Rastegljivom linijom moZete zadati smer, dok u isto vreme unosite rasto-
janje preko tastature. Pogledajte sledeci odeljak.
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SLIKA 2.5
Pozitivni i nega-
tivni smerovi
koordinata u
Dekartovom
sistemu.

SLIKA 2.6
Unosenje rasto-
janja i smera za
crteZ vrata. Rasto-

janja za korisnike Zatvaranje l I

metrickogsistema
data su u zagra-
dama.

IZRADA PRVOG CRTEZA

Prostor za crtanje
novootvorene datoteke.

Koordinatni
podetak 0, O

\i =

Koordinate 5, 4

Koordinate -5, -4

e

@-3,0

[@9,0]
T @0,.15
]
[@0,05]

@3<0

[@9<0]

NACIN ZA BRZO UNOSENJE RASTOJANJA

Tredi nacin na koji moZete uneti rastojanje jeste da pokaZete smer rastegljivom linijom, a zatim
upidete rastojanje preko tastature. Na primer, da biste nacrtali liniju dugu 3 jedinice sleva nade-
sno, izaberite alatku Line s palete Draw. Nakon toga izaberite pocetnu tacku i kursor pomerite
nadesno za proizvoljnu duZinu. Drzite kursor i dalje u Zelienom smeru, a zatim otkucajte 300.
Rastegljiva linija postaje fiksirana linija duZine 3 jedinice.

Objekte odredenih duZina brzo cete nacrtati koristeci ovu metodu, nazvanu metoda direkt-
nog rastojanja (engl. Direct Distance method), u reZimima rada Ortho (ortogonalni rezim rada)
ili Polar Snap koji su opisani u poglavlju 3. Kada treba da unesete rastojanja pod uglovima koji
nisu horizontalni, ili vertikalni, koristite standardni Dekartov ili polarni koordinatni sistem.

UKLANJANJE NEPOTREBNIH MARKERA SA EKRANA

U nekim situacijama, AutoCAD-ov parametar Blipmode moZe biti ukljucen i tada se na
mestima na kojima ste izabrali tacke pojavljuju mali markeri u obliku krsta (engl. blips). Ti
markeri pokazuju gde se na ekranu nalaze tacke koje ste izabrali.
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Markeri nisu deo crteza i nece se pojaviti kada crtez Stampate, ali mogu da smetaju. Da
biste uklonili markere sa ekrana, otkucajte RO. Na ekranu ostaje samo crtez, bez markera.
Isto cete postici i ako izaberete View > Redraw View. Kao Sto cete kasnije videti, ova alatka
moze ukloniti i neke druge probleme koji se pojavljuju na ekranu.

Marker se moZe ukloniti sa ekrana i komandom Regen, samo $to ona uz to aZurira i bazu
podataka crteZa - Sto znadi da brisanje nepotrebnih elemenata sa ekrana traje duzZe. Ova
komanda se koristi za aZuriranje odredenih promena na crtezu. Pozabavicemo se njome u
poglaviju 7.

Da biste ukljucili ili iskljucili rezim rada Blip, u komandnom prozoru otkucajte blipmo-
del], a zatim on(], ili offLl.

Kursori razlicitih oblika i zahtevi za unos

Da bi se uspe$no radilo u AutoCAD-u, klju¢no je razumeti nacin uzajamne komunikacije.
U ovom odeljku saznacete kako AutoCAD traZzi odredene podatke ili informacije. Kada
shvatite format poruka u komandnom prozoru i prepoznate druge dogadaje na ekranu,
lakSe ¢ete nauciti program.

Kao $to poruka u komandnom prozoru pomaze recima, tako kursor pomaze vizu-
elno. Na slici 2.7 prikazani su razli¢iti oblici kursora i dat je kratak opis uloge svakog od
njih. Proucite tu sliku.

SLIKA 2.7 Standardni k
exee . . —_—
Razliciti oblici andarant kursor T
kursora.
Kursor za
izbor tacaka
Kursor za

izbor objekata

Marker Osnap ——— > [
sa opisom alatke

Vektor za pracenje
s pokazivatem koordinata | AN

iz 1114 0

Standardni kursor saopstava da program ¢eka vas nalog. Kada vidite taj kursor, moZete
menjati objekte koristeci &vorove (engl. grips). Cvorovi su kvadrati koji se pojavljuju u
tackama na krajevima ili u sredini objekata kada su izabrani. (MoZzda ih prepoznajete kao
markere iz nekih drugih grafickih programa.)

Kursor za izbor tacaka (engl. Point Selection cursor) pojavljuje se svaki put kada Auto-
CAD ocekuje da izaberete tacku, a moZe se pojaviti i zajedno s rastegljivom linijom. Tada
tacku moZete izabrati miSem ili tako Sto cete preko tastature uneti koordinatu. Kursor
za izbor objekata govori da morate izabrati objekat — miSem ili pomocu opcije za izbor
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objekata. Opcija Osnap (engl. object snap), kao i kursor za izbor tacaka, pojavljuje se kada
ste u rezimu rada Osnap. Tada moZete precizno izabrati karakteristicnu tacku na objektu,
kao §to su tacke na krajevima ili u sredini objekta. Vektor pracenja se pojavljuje kada upo-
trebite opcije Polar Tracking ili Object Snap Tracking. Opcija Polar Tracking pomaZze pri
crtanju ortogonalnih linija, a opcija Object Snap Tracking pomaze da poravnate tacke u
prostoru u odnosu na geometriju postojecih objekata. Opcija Object Snap Tracking radi
u sprezi sa opcijom Osnap. O vektorskom praéenju bice viSe rec¢i u poglavljima 3 i 4.

SAVET  Ako ste iskusan korisnik AutoCAD-a i viSe volite krsti¢ koji prelazi preko celog
ekrana, izaberite Tools > Options. Otvorice se okvir za dijalog Options, pa pritisnite karticu
Display. Postavite vrednost opcije Crosshair Size, levo u donjem delu okvira za dijalog, na vred-
nost 100 i kursor Ce izgledati kao u prethodnim verzijama AutoCAD-a. Kao $to vam opcija
govori, velicinu kursora moZete podesiti na bilo koji procenat ekrana. Uobicajeno je 5%.

Izbor komandnih opcija

Mnoge komande u AutoCAD-u imaju nekoliko opcija o kojima vas program obavestava
prikazujudi njihova imena u komandnom prozoru u formatu zahteva za unos. U vezbi
kojom to ilustrujemo, koristicete komandu Arc.

U crteZima u ortogonalnoj projekciji u SAD, ltik se obi¢no crta da bi se oznacio smer
otvaranja vrata. Na slici 2.8 prikazani su jo$ neki standardni simboli koji se obi¢no kori-
ste u arhitektonskim crtezima. Ovo je deo simbola koji se nalaze na prate¢em CD-u. Vise
informacija nalazi se u dodatku A.

Sada dodajmo ltik malopredasnjem crtezu vrata.

1. Izaberite alatku Arc s palete Draw. Pojavljuje se poruka Specify start point
of arc or [Center]: (Zadajte pocetnu tacku ltika ili [centar]), a kursor postaje
kursor za izbor tacaka.

Ispitajmo zahtev za unos Specify start point of arc or [Center]:.
Podrazumevana opcija (engl. defaulf) navedena je u glavnom delu zahteva za
unos. U ovom sluc¢aju, podrazumevana je ona opcija kojom se zadaje pocCetna
tacka laka. Ako postoje jos neke opcije, one se pojavljuju u zagradama. Kada iza-
berete komandu Arc, vidite rec Center u zagradama, $to govori da 1tk mozZete
pocetii tako $to cete izabrati centralnu tacku umesto pocetne. Ako postoji vise
opcija, one se pojavljuju u zagradama i odvojene su kosom crtom (/). Ukoliko
izri¢ito ne zahtevate neku opciju, AutoCAD nudi onu opciju za koju pretpostavlja
da cete je koristiti.

2. Upisite CO da biste izabrali opciju Center. Pojavljuje se zahtev za unos Specify
center point of arc:. Upisali ste samo C, a ne re¢ Center.

SAVET  Kada se u komandnom prozoru pojavi skup opcija, obratite paznju na velika slova.
Ako na zahteve za unos odgovarate preko tastature, kada zadajete opciju samo upisite velika
slova. Ukoliko vise opcija pocinje istim slovom, velikim slovom se pisu prva dva slova da bi se
napravila jasna razlika izmedu opcija. Takav je slucaj s komandama LAyer i LType.

3. Sada izaberite tacku koja predstavlja centar lika, kod gornjeg levog ugla vrata
(crteZ 1 naslici 2.9). Pojavljuje se zahtev za unos Specify start point of
arc: (Zadajte pocetnu tacku laka).

4. UpiSite @3<0. Korisnici metrickog sistema treba da upisu @9<0. Pojavljuje se
zahtev za unos Specify end point of arc or [Angle/chord Length]:
(Zadajte krajnju tacku lika ili [ugao/duzinu tetive]).
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SLIKA 2.8 O < S S
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— e
KLIZNA VRATA PROZOR

5. Pomerite mi$a i pojavljuje se privremeni ltik koji polazi iz tacke udaljene 3 jedi-
nice nadesno od centralne tacke koju ste izabrali i rotira oko tog centra, kao na
gornjem crtezu slike 2.9. (Korisnici metrickog sistema videce privremeni lik koji
polazi iz tacke udaljene 9 jedinica nadesno od centralne tacke.)

Kako poruka u zahtevu za unos pokazuje, na raspolaganju su vam tri opcije.
MozZete zadati ugao, duzinu tetive ili tacku na kojoj se ltk zavrsava. Ponudeni
parametar je krajnja tacka ltka. Kursor je promenio oblik u kursor za izbor tacaka,
ato znaci da program ocekuje da zadate tacku. Ako se opredelite za ovu opciju,
samo izaberite tacku na ekranu i tako pokaZite gde ltik treba da se zavrsi.

6. Kursor pomerite tako da pokazuje tacke u pravcu vertikalno od centra lika.
Videcete kako vektor Polar Tracking prelazi u vertikalan poloZaj.

M.

i Folar, 2 D6l ¢ 30 |
I |
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7. Pritisnite levi taster mi$a i zadajte krajnju tacku luka. Lk je sada fiksiran na
mestu, kao na tre¢em crtezu slike 2.9.

SLIKA 2.9
KoriScenje
komande Arc.
E
Zadajte mesto
centra Ilka
§
=Y =
e
| Pocetna tacka ldka
_
'
& ™~
/I y
Krajnja tacka lika | \
E =1
]
S

U upravo zavr§enoj vezbi naucili ste da radite sa zahtevima za unos preko komand-
nog prozora i unosom komandi preko tastature — §to su neophodne vestine za rad sa
sloZenijim funkcijama programa AutoCAD.
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AutoCAD ima potpuno definisanu strukturu zahteva za unos. Prvo zadajete
komandu koja za uzvrat nudi opcije u obliku zahteva za unos. Zavisno od opcije koju
tada izaberete, moZe se desiti da dobijete drugi skup opcija, ili da zahtev za unos naloZi
da nesto uradite (recimo, da izaberete tacku, objekat ili da unesete vrednost).

Kao $to je prikazano na slici 2.10, redosled komandi podseca na grananje drveta.
Vezbajte, i sasvim Cete se sroditi sa ovim, u sustini rutinskim postupcima. Posto potpuno
savladate rad s paletama alatki, komandnim prozorom i okvirima za dijalog, ostatak pro-
grama moci cete nauciti i sami.

SLIKA 2.10
Tipi¢na struktura
komandi na pri-
meru komande
Arc. Videcete raz-
licite poruke, u
zavisnosti od
opcije koju izabe-
rete dok napredu-
jete kroz
komandu. Ova
slika pokazuje
kako sve mozete
nacrtati lak.

Specify start point of arc or [CEnter]:

Specify second point of arc or [CEnter/ENd]:
Specify end point of arc:

Specify includ

Specify end point of arc: (pick an endpoint location)
Specify center point of arc or [Angle/Direction/Radius]:

1

Specify center point of arc: (pick a center point)
Specify start point of arc: (pick a start point)
Specify end point of arc or [Angle/chord Length]:

I
| Specify length of chord:

Specify Included angle: (Indicate a chord length)
(Indicate an angle)

(Pick a point for the end
of the arc)

Specify radius of arc:
Specify tangent direction for the start point: of arc:
Specify included angl\e of arc: (Indicate a direction angle)

(Indicate a radius)

(Indicate an including angle)

ed angle:

Specify center point of arc: (Pick an endpoint location)
Specify end point of arc or [Angle/chord Length]:

Specify length of chord:
I—) (Indicate a chord length)

(Indicate an angle)
(Pick a point for the end of the arc)

L————————— > (Pick a point for the end of the arc)

1ZBOR OPCIJA 1Z PRIRUCNOG MENLJA

Sada znate da moZete izabrati opcije komandi tako $to cete ih otkucati. Isto tako, moZete
pritisnuti desni taster misa u bilo kom stadijumu komande da biste otvorili priru¢ni meni
koji sadrZi te iste opcije. Na primer, u koraku 2 iz prethodnog veZbanja, uneli ste CC da
biste AutoCAD-u saopétili da birate centar liika. Umesto da to otkucate, moZete pritisnuti
desni taster miSa da biste otvorili priru¢ni meni sa opcijama koje u tom trenutku mozete
primeniti na komandu Arc.

Emiles
e

Pan
Lo

Pored opcija prikazanih u zahtevu za unos komandi, priru¢ni meni nudi i jo§ neke
opcije, na primer, Enter, Cancel, Pan i Zoom. Opcija Enter jednaka je pritiskanju Cl.
Opcija Cancel ponistava tekué¢u komandu. Opcije Pan i Zoom omogucavaju da podesa-
vate prikaz dok radite s teku¢om komandom.

Tokom rada sa AutoCAD-om, otkric¢ete da u bilo kom trenutku mozete pritisnuti desni
taster miSa da biste dobili spisak opcija, poznat kao priru¢ni meni (engl. shortcut menu).
Ovaj meni zavisi od konteksta, tako da cete videti samo one opcije koje se odnose na
odredenu komandu ili aktivnost koja je u toku. Ako pritisnete desni taster miSa kada
AutoCAD ocekuje tacku, izbor objekta ili numericku vrednost, nece se pojaviti priru¢ni
meni. AutoCAD ce u tom slucaju pritiskanje desnog tastera misa tretirati kao .
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Imajte na umu da poloZaj kursora u trenutku kada pritisnete desni taster misa odre-
duje sadrzaj priru¢nog menija. Ve¢ ste videli da moZete pritisnuti desnim tasterom misa
neku paletu alatki da biste dobili spisak ostalih paleta. Ako pritisnete desnim tasterom
miSa u komandnom prozoru, prikazace se spisak operacija koje moZete primeniti, kao
$to je ponavljanje jedne od poslednjih pet komandi koje ste koristili, ili kopiranje posled-
njih komandnih aktivnosti na Clipboard.

Ako pritisnete desnim tasterom mi$a povrsinu za crtanje kada nijedna komanda nije
aktivna, prikazace se skup osnovnih funkcija za unosenje izmena u datoteku, a neke od
njih su Cut, Paste, Undo, Repeat (ponavljanje poslednje komande), Pan i Zoom.

el BT

Ot
Loy
oy Wl B Poank
Faete

Linesies

Pan
Toaa

Gk Sadert..
Fred
CpHor:

Kada se nadete u nedoumici $ta da uradite u AutoCAD-u, pritisnite desni taster misa
i pogledajte spisak funkcija. Kasnije u knjizi bice viSe re¢i o tim funkcijama. Zasad, poza-
bavimo se problemom izbora objekata.

Ako ste iskusan korisnik AutoCAD-a i vi$e biste voleli da svako pritiskanje desnog
tastera mi$a bude jednako pritiskanju 0, kao u prethodnim verzijama, podesite pona-
$anje AutoCAD-a. U dodatku B naci ¢ete detalje o tome kako da podesite desni taster
miSa. Imajte na umu da su veZbanja u knjizi podeSena tako da se podrazumeva da ce se,
kad pritisnete desni taster misa, otvoriti priru¢ni meni.

Izbor objekata

AutoCAD raspolaze mnogim opcijama za izbor objekata. Ovaj odeljak je podeljen na dve
celine. U prvoj razmatramo izbor objekata na nacin specifican za AutoCAD. Druga
celina se bavi metodom izbora objekata koja se koristi u najpopularnijim grafickim pro-
gramima — Noun/Verb. Dobro je da se sa ovim metodama upoznate na samom pocetku
jer one imaju jednu od najvaznijih uloga u radu sa AutoCAD-om.
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SLIKA 2.11

Prikaz izabranog _—
objekta (vrata)

predstavljen je

tackastim

linijjama.

IZBOR OBJEKATA 53

SAVET  Ako objekte treba da birate po njihovim karakteristikama umesto po njihovom
poloZaju, koristite alatke Quick Select and Object Selection Filters (brz izbor i filtri za izbor
objekata) opisane u poglavlju 13. Ove alatke omogucavaju da lako izaberete skup objekata na
osnovu njihovih osobina, ukljucujuci tip objekta, boju, dodeljene slojeve itd.

Izbor objekata u AutoCAD-u

Mnoge komande AutoCAD-a daju zahtevzaunos Select objects: (izaberite objekte).
Pored ovog zahteva za unos, i kursor menja oblik u mali kvadrat (slika 2.7). Uvek kada
vidite ovakav zahtev za unos objekata i cetvrtasti kursor, na raspolaganju je nekoliko
opcija za izbor. Cesto se desava da se predomislite dok birate objekte na ekranu ili da
slucajno izaberete objekat koji niste hteli. Pogleda¢emo vecinu raspoloZivih opcija za
izbor u AutoCAD-u i nauciti $ta treba da radite ako izaberete pogresan objekat.

Pre nego $to nastavite, iskljucite opcije Running Osnap i Osnap Tracking. Iako veoma
korisne, one mogu da zbunjuju pocetnike. S njihovim osobinama detaljnije cete se upo-
znati kasnije u knjizi.

1. Najpre proverite da li su opcije Running Osnap i Osnap Tracking uklju¢ene. Da
biste to uradili, pogledajte dugmad na kojima piSe Osnap i Otrack, na statusnoj
traci pri dnu AutoCAD-ovog prozora. Ako su opcije ukljucene, njihova dva dugmeta
izgledaju kao da su pritisnuta. Ukoliko izgledaju kao na sledecoj slici, nastavite.

| sMaF GRID| DATHO| POLER] DEMAF (G LT | [MoniL

2. Da biste iskljucili opcije Running Osnap ili Osnap Tracking, pritisnite dugme
Osnap, odnosno Otrack — oba su na statusnoj traci. Kada su iskljucena, izgledace
kao da nisu pritisnuta.

Nastavimo i pogledajmo kako da izaberemo objekat u AutoCAD-u.

1. Izaberite ikonicu Move s palete Modify ili otkucajte M.

2. Nazahtevzaunos Select objects: izaberite dve horizontalne linije koje ¢ine
crteZ vrata. Kao $to ste videli u pros§lom poglavlju, uvek kada AutoCAD traZi da
izaberete objekat, kursor menja oblik u mali kvadrat. To znaci da ste u rezimu
rada za izbor objekta (engl. object selection mode). 1zabrani objekat se na ekranu
prikazuje tackastom linijom (slika 2.11).
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SAVET  Izabrani objekat menja izgled; nije viSe nacrtan punim linijama, nego tackastim.
Tako ste ivizuelno obavesteni da ste izabrali objekat na koji ce biti primenjena tekuca
komanda ili naredne komande.

3. Posto ste izabrali objekte, moZete ponistiti izbor nekih od njih. Pritisnite U0 na
tastaturi. Jedna od linija viSe nije prikazana kao tackasta. Kada pritisnete UL,
ponistavate izbor objekata, jednog po jednog, obrnutim redosledom od onog
kojim ste ih birali.

4. Postoji jos jedan nacin da ponistite izbor objekata: drzite pritisnut taster Shift i
izaberite liniju koja je ostala tackasta. Linija opet postaje puna, $to znaci da nije
viSe izabrana.

Dosad ste verovatno ponistili izbor obe linije. Poku3ajmo s jo$ jednom metodom
izbora grupe objekata.

5. Da biste obuhvatili objekat prozorom, otkucajte WO. Kursor menja oblik u kursor
za izbor tacaka, a zahtev za unos se menja u:

Specify first corner: (Zadajte prvi ugao)

6. Izaberite tacku ispod i levo od pravougaonika koji predstavlja vrata. Dok pomerate
kursor preko ekrana, pojavljuje se prozor koji se $iri preko povrsine za crtanje.

7. Posto prozor potpuno obuhvati vrata (ali ne i 1k), pritisnite taster misa i izabrali

ste vrata. Pomocu prozora birate samo objekte koji su potpuno obuhvadeni njime,
kao sto je prikazano na slici 2.12.

SLIKA 2.12 I
Biranje objekta
vrata obuhvace-
nih prozorom.
Drugi ugao prozora

Prvi ugao prozora

SAVET  Nemojte da pobrkate prozor za izbor iz prethodne vezbe s prozorom Zoom, koji ste
koristili u poglavlju 1; prozor Zoom definise povrsinu crteZa koju treba uvecati. Zapamtite da
opcija Window komande Zoom radi razlicito od prozora drugih komandi za uredivanje.

UPOZORENJE  Kada koristite miSa, a niste sasvim ovladali njime, veoma lako se moZe desiti
da slucajno pritisnete desni taster misa umesto levog tastera za izbor, i obratno. Ako pritisnete
pogresan taster, dobicete pogreSan rezultat. Ukoliko mis§ ima dva tastera, desni taster ce se
ponasati ili kao taster U ili cete njime otvarati prirucni meni, u zavisnosti od tekuce radnje. Kao
taster [ ponasace se pri izboru objekata, a u ostalim slucajevima pojavljuje se prirucni meni.
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8. Posto ste izabrali cela vrata, bez ltika, pritisnite . Na taj nacin obaves$tavate Auto-
CAD da ste izabrali objekte. Nemojte zaboraviti da pritisnete 0 odmah posto iza-
berete objekte koje hocete da menjate. Pojavljuje se nov zahtev za unos, Specify
base point or displacement: (zadajte baznu tacku ili pomeranje), a kursor
menja oblik u kursor za izbor tacaka.

Sada znate kako se biraju objekti u AutoCAD-u, ali jo§ smo usred komande Move.
U sledecem odeljku govori¢emo o zahtevu za unos koji se upravo nalazi na vasim ekra-
nima, i o unoSenju baznih tacaka i rastojanja za pomeranje objekta.

ICONTROLA PRIKAZA NA STATUSNOJ TRACI

Na krajnjoj desnoj strani statusne trake videcete strelicu nadole. Ona otvara meni kojim kon-
troliSete prikaz statusne trake. Ovaj meni koristite da biste funkcije koje se nalaze na status-
noj traci ukljucili ili iskljucili. Ako se pored naziva funkcije nalazi znak za potvrdu, znaci da je
ona aktivna. Ako, iz nekog razloga, ne vidite dugmad koju smo pomenuli u prethodnoj
vezbi, proverite u ovom meniju jesu li sve opcije na statusnoj traci ukljucene. Verzija LT nema
opciju Otrack u statusnoj traci.
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DEFINISANJE BAZNIH TACAKA

Kada pomerate ili kopirate objekte, AutoCAD trazi da zadate baznu tacku (engl. base
point). AutoCAD-u morate posebno zadati odakle i dokle se objekat pomera. Bazna
tackaje precizno odredeno mesto i u odnosu na nju definiSete rastojanje i smer pome-
ranja. Posto definiSete baznu tacku, AutoCAD-u moZete zadati pravac pomeranja
objekta u odnosu na nju.

1. Da biste izabrali baznu tacku, drZzite pritisnut taster Shift i pritisnite desni taster
misa. Na ekranu se pojavljuje meni Object Snap (Osnap).

UPOZORENJE  Kada pritiskate desni taster misa, proverite da li se kursor nalazi unutar
povrsine za crtanje. U suprotnom, necete dobiti rezultate opisane u knjizi.

2. Iz menija Osnap izaberite Intersection. Meni Osnap nestaje.

3. Pomerite kursor do donjeg desnog ugla vrata. Primeticete da se u uglu pojavljuje
malo x. To je marker Osnap.
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4. Kada se pojavi marker Osnap, ne pomerajte misa nekoliko sekundi. Dobicete
poruku da je AutoCAD izabrao tacku Osnap.

5. Sada pritisnite levi taster miSa da biste izabrali presek oznacen markerom Osnap.
Kada marker Osnap vidite na tacki koju hocete da izaberete, ne morate kursorom
pokazati tacno mesto. Samo pritisnite levi taster miSa i tacka Osnap je precizno
izabrana (slika 2.13). U ovom slucaju, izabrali ste ta¢no presek dve linije.

SLIKA 2.13
Koriscenje
kursora Osnap.

Marker preseka

6. NazahtevzaunosSpecify second point of displacement or <use first
point as displacement>: (zadajte drugu tacku pomeranjaili <upotrebite prvu
tacku kao pomeranje>), drzite taster Shift i ponovo pritisnite desni taster misa.
Ovog puta, pojavice se Endpoint Osnap. Umesto da opciju izaberete pomocu
misa, otkucajte slovo E.
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7. Sada izaberite donji desni kraj ltika koji ste ranije nacrtali. (Upamtite, kursor treba
samo da priblizavate krajnjoj tacki dok se ne pojavi marker Osnap.) Vrata se pome-
raju tako da se izabrani presek vrata precizno spaja s krajnjom tackom ltika (slika
2.14).

SLIKA 2.14
Pravougaonik u
novom poloZaju
posle koriscenja
opcije Endpoint

Marker krajnje tacke

Osnap. ! /

Kao $to vidite, opcija Osnap omogucava da izaberete odredene tacke na objektu. U
ovoj vezbi koristili ste opciju za izbor krajnje tacke (Endpoint) i opciju za izbor preseka
(Intersect), ali na raspolaganju imate i druge opcije koje ¢u objasniti kasnije, u poglavlju 3.
MoZda ste primetili da je marker Osnap drugaciji za svaku opciju koju ste koristili. O tome
ce biti viSe reci u poglavlju 3, a sada nastavimo sa izborom tacaka.

SAVET  Verovatno ste primetili poruku Use first point as displacement u zahtevu za
unos u koraku 6. To znaci da ce se, ako pritisnete [1 umesto da izaberete neku tacku, objekat
pomeriti na osnovu koordinata tacke koju ste izabrali kao baznu. Ako je, na primer, tacka koju
ste izabrali na koordinati 2,4, objekat ce se pomeriti 2 jedinice po x osi i 4 jedinice po y osi.

Ako precizno rastojanje i smer pomeranja ili kopiranja objekta upisujete preko tasta-
ture, izaberite bilo koju tacku na ekranu kao baznu tacku. MoZete i samo upisati znak @
i pritisnuti 0 kao odgovor na zahtev za unos; zatim upisSite relativne koordinate druge
tacke. Upamtite, @ oznacava poslednju izabranu tacku. U sledecoj vezbi pomericete
cela vrata za 1 jedinicu, pod uglom od 45 stepeni. Korisnici metrickog sistema pomerice
vrata za 3 jedinice, pod uglom od 45 stepeni.

1. Izaberite alatku Move s palete Modify.

2. Unesite PO. Skup objekata koje ste obuhvatili prethodnom komandom za izbor
postaje izabran. P je opcija koja bira prethodno izabran skup objekata.

3. Posto jo§ radite u reZimu za izbor objekata (engl. object selection mode), izaberite
lik da i njega ukljucite u izabrane objekte. Cela vrata, ukljucujuci i ik, postaju
izabrana.

4. Pritisnite O da biste obavestili AutoCAD da ste zavrsili izbor. Kursor postaje kursor
za izbor tacaka.

5. Pojavljuje se zahtev za unos Base point or displacement: (bazna tacka ili
pomeranje). Izaberite baznu tacku na mestu izmedu vrata i leve strane ekrana
(slika 2.15).
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SLIKA 2.15
Izabrana vrata i
bazna tacka levo
od vrata. Bazna
tacka se ne mora
nalaziti na
objektu koji
pomerate. LENTESS .

Bazna tacka

=

6. Polako pomerajte kursor i primeticete da se pomeraju i vrata, kao da je bazna
tacka koju ste izabrali pri¢vrSéena za njih. Vrata se pomeraju s kursorom, na stal-
noj udaljenosti od tacke, sto ilustruje odnos bazne tacke i izabranog objekta.

7. UpiSite @1<450. Korisnici metrickog sistema neka upisu @3<450]. Vrata se pome-
raju na nov poloZaj na ekranu, na udaljenost od jedne jedinice (tri jedinice) od
prethodnog polozaja i pod uglom od 45 stepeni.

SAVET  Ako AutoCAD ceka da zadate komandu, poslednju zadatu komandu moZete pono-
viti tako $to Cete pritisnuti razmaknicu ili taster U. Isto tako, mozete pritisnuti desnim tasterom
misa povrsinu za crtanje i izabrati opciju s vrha spiska. Ako desnim tasterom misa izaberete
komandni prozor, prirucni meni ¢e ponuditi poslednje koris¢ene komande.

Vezba pokazuje da se bazna tacka ne mora nalaziti na objektu na kome radite, ona
moze biti bilo gde na crtezu. Videli ste da moZete ponovo da izaberete skup objekata koji
su ve¢ bili izabrani, a da ne ponavljate postupak biranja.

OSTALE OPCIE ZA 1ZBOR

Postoji jos nekoliko opcija za izbor koje niste isprobali. U vezbama koje slede videcete kako
rade, a ako ste nestrpljivi, isprobajte ih i sada. Da biste upotrebili te opcije, upisite njihove skra-
cenice preko tastature (ispisane su u zagradama) na svaki zahtev za unos Select object:.

All [alld] Ovom komandom birate sve objekte s crteza, izuzev slojeva koji su zamrznuti
ili zakljucani (viSe detalja o slojevima naci cete u poglavlju 4).

Crossing [c[J] Sli¢na je opciji Select Window, samo $to se pomocu nje biraju svi objekti
koji su u celosti ili delimi¢no obuhvaceni prozorom.

Crossing Polygon [cp[J] Ponasa se slicno opciji Window Polygon, s tim Sto se, kao i kod
opcije Select Crossing, biraju svi objekti koji su u granicama poligona ili prelaze preko.
Fence [fO] Pomocu ove opcije biraju se objekti preko kojih prelazi priviemena linija koja
se zove ograda (engl. fence). Izgleda kao da ste linijom precrtali objekte koje hocete da
izaberete. Kada aktivirate ovu komandu, tacke moZete birati na isti nacin na koji to radite
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kada crtate niz linijskih segmenata. Po zavrsenom radu sa ,ogradom” pritisnite [J, a zatim
birajte druge objekte ili ponovo pritisnite 0 da biste zavrsili biranje.

Last [IT0] Pomocu ove opcije birate objekat koji ste poslednji nacrtali.

Multiple [m] Omogucava da izaberete nekoliko objekata unapred, pre nego sto ih
AutoCAD istakne. Kada radite s velikim datotekama, a pojedinacno birate objekte, Auto-
CAD pravi pauzu posle svakog izbora jer mu treba vremena da locira i istakne svaki obje-
kat. Opcija Multiple ubrzava postupak dozvoljavajuci da prvo brzo oznacite sve objekte, a
zatim ih izaberete pritiskom na . Ova opcija nema svoj ekvivalent u menijima.

Previous [p] Ova opcija omogucava da izaberete poslednji objekat ili skup objekata
koji su prethodno bili menjani ili samo izabrani.

Window [w(J] Pomocu ove opcije moZete prikazati standardan prozor za izbor. Ona je
prigodna kada je prozor za crtanje ispunjen brojnim elementima crteZa tako da se opci-
jom Autoselect ne moZe obuhvatiti skup Zeljenih objekata (pogledajte stavku Auto). Pri-
mena standardnog prozora sprecava da slucajno izaberete objekat koji niste hteli.

Window Polygon [wp[J] Objekte birate obuhvatajuci ih poligonom nepravilnog
oblika. Kada koristite ovu opciju, pojavljuje se zahtev za unos First polygon point:
(Prva tacka poligona). Tada birate tacke kojima su definisane granice poligona. Dok
birate tacke, pojavljuje se poruka Undo/<Endpoint of line>: (Ponisti/<Krajnja tacka
linije>). Izaberite onoliko tacaka koliko vam je potrebno da biste zadali granice. Delove
granicne linije moZete tokom rada ponistiti tako Sto cete pritisnuti alatku Undo s palete
Standard ili tako $to cete pritisnuti taster U na tastaturi. Kada definiSete granice, pritisnite
0. Obuhvaceni objekti bice izabrani i vraca se zahtev za unos Select object omoguca-
vajudi da upotrebite i druge opcije za izbor.

Sledece dve opcije za biranje takode su dostupne, ali se veoma retko koriste. Namenjene

su formiranju prilagodenih opcija menija ili prilagodenih alatki s paleta.

Auto [auld] Ako izaberete tacku izvan objekta, aktivira se standardni automatski prozor
(engl. window) ili presecni prozor (engl. crossing window) — pogledajte odeljak Upotreba
opcije za izbor Autoselect u ovom poglavlju. Standardni prozor se aktivira kada se dva
ugla prozora biraju sleva nadesno. Presecni prozor se aktivira kada se dva ugla izaberu
zdesna nalevo. Ako izaberete ovu opciju, ona ostaje aktivna dok ne izaberete sledecu
komandu. Opcija Auto je namenjena upotrebi u sistemima kada je funkcija automatskog
izbora iskljucena.

Single [si0)] Ova opcija primorava tekucu komandu da izabere samo jedan objekat. Ako
je upotrebite, moZete izabrati jedan objekat; tada se tekuca komanda odmah izvrsava kao
da ste pritisnuli O ¢im ste izabrali objekat. Ova komanda nema ekvivalent u menijima.

Danas je u skoro svim grafickim programima precutno prihvacen izbor objekata

metodom Noun/Verb. Ta metoda zahteva da objekte izaberete pre nego $to zadate

komandu za njihovo uredivanje. U slede¢im veZbama pokazacéu kako se ova metoda

koristi u AutoCAD-u.

Videli ste da AutoCAD prikazuje krsti¢ s malim kvadratom kada o¢ekuje komandu.

Taj kvadrat, koji je pridodat kursoru, oznacava da pomocu kursora moZete birati

objekte. Program obavestava da kursorom moZete birati objekte iako na komandnoj
liniji, koja se nalazi na dnu ekrana, nijedna komanda nije aktivna. Kvadrat nestaje istog

trenutka kada aktivirate komandu koja trazi da birate tacke. Kursor s kvadratiéem
zvaéemo od sada standardni kursor (engl. standard cursor).
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SAVET  Ovo poglavlje predstavlja standardne AutoCAD-ove metode za izbor objekta. Auto-
CAD nudi i metode izbora koje su vam verovatno poznatije. Kako upravljati metodama izbora
objekata, saznacete u odeljku o opcijama Selection Modes u dodatku B. U tom dodatku opi-
sano je i kako da promenite velicinu kursora s kvadraticem za izbor (engl. pickbox).

Poku$ajmo sada da pomerimo objekte. Prvo ¢emo ih izabrati, a zatim upotrebiti
komandu Move.

1. Najpre dvaput pritisnite taster Esc da biste bili sigurni da AutoCAD nije usred
komande koju ste moZda slu¢ajno zadali. Zatim izaberite 1tik. Dok birate 1k, na
njegovoj srednjoj tacki i na njegovim krajnjim tackama pojavljuju se kvadrati koji
se zovu cvorovi (engl. grips). Oni su vam mozda poznati iz drugih grafickih pro-
grama kao radne tacke (engl. workpoints). Nesto kasnije bice prilike da radite
s njima.

2. Izaberite Move s palete Modify. Kursor se pretvara u kursor za izbor tacaka. Obra-
tite paZnju na to da ¢vorovi na ltiku nestaju, ali je 1tk i dalje izabran.

3. Nazahtevza unos Base point: (bazna tacka), izaberite bilo koju tacku na
ekranu. Pojavljuje se zahtev za unos To point: (do tacke).

4. UpiSite @1<00. Korisnici metrickog sistema neka unesu @3<00. L{ik se premesta
na nov polozaj, udaljen jednu jedinicu (3 jedinice) nadesno.

UPOZORENJIE  Ako je rezultat vezbe drugaciji nego $to je ovde opisano, moZda je u vasoj
kopiji AutoCAD-a metoda Noun/Verb iskljucena. Da biste je aktivirali, uradite sledece: izabe-
rite Tools > Options i otvorice se okvir za dijalog Options. Zatim izaberite karticu Selection. U
grupi Selection Modes ukljucite metodu izbora Noun/Verb. Pritisnite OK kada zavrSite.

U ovoj vezbi liik ste izabrali pre nego §to ste zadali komandu Move. Kada ste izabrali
alatku Move, nije se pojavila poruka Select object:.Umesto toga, AutoCAD pretposta-
vlja da ste izabrani lik hteli da pomerite i odmah prelazi na zahtev za unosBase point:.

UPOTREBA OPCIJE ZA 1ZBOR AUTOSELECT
U sledecem koraku, pomocu opcije Autoselect pomeramo ostatak vrata u istom smeru.

1. Izaberite ispod i levo od pravougaonika koji predstavlja vrata. Proverite da niste
slu¢ajno izabrali i sama vrata. Pojavljuje se prozor koji moZete razvlaciti po ekranu
dok pomerate kursor. Ukoliko kursor pomerite levo od poslednje izabrane tacke,
konture prozora bice prikazane tackastim linijama (gornji crteZ sa slike 2.16). Ako
kursor pomerite desno od izabrane tacke, konture prozora ponovo postaju pune
(donyji crtez sa slike 2.16).

2. Sada izaberite tacku ispod i desno od vrata, tako da vrata ostanu potpuno obu-
hvacena prozorom (donji crtez na slici 2.16). Vrata postaju izabrana (ponovo
moZete videti ¢vorove koji se pojavljuju na krajnjim tackama i sredinama izabra-
nih linija).

3. Aktivirajte ponovo alatku Move. Pojavljuje se zahtev za unos bazne tacke kao i u
prethodnoj vezbi.

4. Izaberite bilo koju tacku na ekranu, zatim upiSite @1<00 (@3<00 za korisnike
metrickog sistema). Vrata se spajaju s lilkom.
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SLIKA 2.16
Tackasti prozor
(gornji crtez)
ukazuje na to
da je aktivirana
opcija za izbor
metodom pre- N
secnog prozora; V\ ] |
prozor punih i = S

linija (donji
crtez) ukazuje
na to da je aktivi-
rana opcija za
izbor standard- Presecni prozor
nim prozorom.

=

Standardni prozor za izbor

i ~

Dva razlicita prozora — tackasti prozor i prozor punih linija — predstavljaju prese¢ni
prozor i standardni prozor. Ukoliko koristite standardni prozor, bi¢e izabrano sve §to je
u celini njime obuhvaéeno. Ako koristite prese¢ni prozor, bice izabrano sve $to prolazi i
ono $to je u prozoru. Te dve vrste prozora pokrecu se automatski kada standardnim kur-
sorom ili kursorom za izbor tacaka pritisnete bilo koji prazan deo povr$ine za crtanje;
otud naziv Autoselect.

Sada cete objekte birati pomocu automatskog presec¢nog prozora.

1. Izaberite tacku ispod i desno od vrata. Dok pomerate kursor nalevo, pojavljuje se
presec¢ni (tackasti) prozor.

2. Izaberite sledecu tacku tako da prozor obuhvati vrata i deo ltka (slika 2.17).
Izabracete cela vrata zajedno s lakom.

3. Izaberite alatku Move.

4. Izaberite bilo koju tacku na ekranu i upisite @1<1800 (@3<1800 za korisnike
metrickog sistema). Vrata se vracaju u prvobitni poloZaj.
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SLIKA 2.17
Vrata obuhva-
¢ena presecnim
prozorom.

Tokom rada postace jasno da su, u veéini slucajeva, za biranje objekata jedino potre-
bni standardni prozor i presecni prozor opcije za izbor Autoselect. Oni Stede vreme, pa
bi valjalo da dobro savladate rad s njima.

Pre nego $to nastavimo, upotrebite komandu File > Save da biste snimili datoteku
Vrata. Nije potrebno da sa¢uvate izmene koje ¢emo uneti u sledecoj veZzbi, te zato crtez
snimite sada i sacuvajte ga u sada$njem obliku.

Ogranicenja za izbor objekata metodom Noun/Verb

Ako objekte radije birate metodom Noun/Verb, treba da znate da se ona koristi sa odre-
denom podgrupom AutoCAD-ovih komandi. Nabrojacemo ih po abecednom redosledu:

Array Copy Hatch Rotate
Block Dview List Scale
Change Erase Mirror Stretch
Chprop Explode Move Whblock

Kada primenjujete komandu kojom se bira viSe od jedne grupe objekata, ne moZete
koristiti metodu Noun/Verb. Ovu listu ne morate pamtiti zato $to ¢ete odmah znati da li
komanda prihvata izbor objekata metodom Noun/Verb. Komande koje ga ne prihvataju
obrisace izbor, a zatim prikazati zahtev za unos Select object:.

Sada je pravi trenutak da napravite pauzu. Izadite iz AutoCAD-a i kasnije se vratite na
ovo mesto u knjizi. Kada budete Zeleli da nastavite, pokrenite AutoCAD i otvorite dato-
teku Vrata.

Upotreba c¢vorova za uredivanje objekata
(funkcija Grips)
Dok ste birali vrata, videli ste ¢vorove na krajnjim i srednjim tackama linija i lukova.

Cvorovi se mogu koristiti za neposredno menjanje oblika objekata ili za brzo preme-
Stanje i kopiranje objekata.
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UPOTREBA CVOROVA ZA UREDIVANJE OBJEKATA (FUNKCIJA GRIPS)

UPOZORENJIE  Ako se u prethodnoj vezbi nisu pojavili cvorovi na vratima, mozda je u vasoj
verziji programa AutoCAD-a iskljucena funkcija Grips. Kako Cete je ukljuciti, saznacete u tek-
stu o cvorovima u dodatku B.

Dosad ste naucili da se rad u AutoCAD-u obavlja postupno, u koracima. Na primer,
da biste nacrtali lik, prvo zadajete komandu Arc, zatim prolazite kroz niz radniji koje
ukljucuju i odgovaranje na zahteve za unos i izbor tacaka. Kada sve to zavrsite, lik je
gotov i AutoCAD je spreman za slede¢u komandu.

Funkcija Grips ima drugaciju ulogu. Cvorovi nude mali ali moc¢an skup funkcija za
uredivanje koje ne podlezu dosad kori§¢enom redosledu komanda/zahtev za unos/
unos. LakSe cete raditi u sledecoj vezbi ako funkciju Grips zamislite kao ,,podskup” stan-
dardnih nacina rada sa AutoCAD-om.

Da biste veZbali upotrebu ¢vorova, moracete priviemeno izmeniti sadasnji crtez
vrata (Vrata.dwg).

Rastezanje linija pomocu ¢vorova
U ovoj vezbi rastegnucete jedan ugao vrata hvatajuci dve linije za ¢vorne tacke.

1. Pritisnite taster Esc da biste bili sigurni da nijedna komanda nije aktivna. [zabe-
rite tacku ispod i levo od vrata da biste aktivirali prozor za izbor.

2. Pritisnite iznad i desno od pravougaonog dela vrata koja treba izabrati.

3. Postavite kursor na donji levi ¢vor pravougaonika, ali ne pritiskajte taster misa.
Obratite paznju na to kako kursor skace na mesto na kome se nalazi ¢vor i kako
¢vor menja boju.

4. Premestite kursor do drugog ¢vora. Vidite da kursor opet skace na ¢vor. Kada se
postavi na ¢vor, kursor se smesta tacno u njegov centar. To znaci da kursor koji se
postavi na ¢vor, recimo krajnje tacke, precizno pronalazi centar krajnje tacke
objekta.

5. Pomerite kursor do ¢vora u gornjem levom uglu pravougaonika i izaberite ga.
Cvor menja boju, pa za njega kazemo da je aktivan évor (engl. hot grip). Pojavljuje
se zahtev za unos:

**STRETCH**

Specify stretch point or [Base point/Copy/Undo/eXit]:
(Razvucite do tacke ili [bazna tacCka/kopiranje/poniS$tavanje/
izlaz])

Ovaj zahtev obavestava da je komanda Stretch aktivna. Pregledajte opcije koje su
vam na raspolaganju. Dok pomerate kursor, ugao prati njegovo kretanje, a linije
pravougaonika se rastezu (slika 2.18).

SAVET  Kada misem izaberete ¢vor, on menja boju (obic¢no u crvenu) i zove se aktivan ¢vor.
Velic¢inu i boju cvorova mozete menjati preko okvira za dijalog Grips. Detaljnija objasnjenja
pogledajte u dodatku B.

6. Pomerite kursor prema gornjem kraju ltika i izaberite tacku tako Sto éete priti-
snuti taster misa. Pravougaonik se deformise, a uglovi se poklapaju sa izabranom
tackom (slika 2.18).
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SLIKA 2.18
Rastezanje linija
pomocu aktivnih e
¢vorova. Gornji
crtez prikazuje ’
pravougaonik ciji \
se jedan ugao

rasteZe navise. | REEdy EALTT |
Donji crtez poka-
zuje novi polozaj
ugla na vrhu ltka.

—

SAVET  Ako izaberete ¢vor u uglu, AutoCAD bira oba ¢vora na linijama koje se preklapaju.
Kad rastegnete ugao od njegovog pocetnog mesta, prate ga krajnje tacke obe linije.

U ovoj vezbi upoznali ste komandu STRETCH. Nju zadajete tako $to miSem birate ¢vor.
Kao $to Cete videti, na raspolaganju su vam mnoge druge komande za aktivne ¢vorove.

1. Vidite da ¢vorovi i dalje postoje na objektu. MiSem izaberite ¢vor koji ste ranije
pomerili da bi ponovo postao aktivan.

2. Pritisnite desni taster misa i pojavljuje se priru¢ni meni sa opcijama za menjanje
¢vorova (meni je prikazan na sledecoj strani).

3. Sliste izaberite Base Point i mi§em pritisnite tacku desno od aktivhog ¢vora. Ako
sada pomerite kursor, pomerice se i aktivni ¢vor, ali ¢e zadrzati isti odnos prema
kursoru.

4. Ponovo pritisnite desni taster miSa i zatim izaberite opciju Copy iz priru¢nog
menija pa onda upiSite @1<-300 (@3<-300 za korisnike metrickog sistema).
Umesto da pomerite aktivni ¢vor i promenite linije, pravite kopiju dveju linija cije
su krajnje tacke za 1 jedinicu (3 jedinice) ispod i desno od prethodnih.
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TEHER

Bl Foink
Cop

Liniko
Fropacims
Edk

5. Izaberite jo$ jednu tacku, tacno ispod poslednje. Napravicete jo§ kopija.

6. Pritisnite Oili upiSite X0 da biste zavrsili rad s komandom Stretch. Isto moZete
uraditi i ako ponovo pritisnete desni taster mi$a i izaberete opciju Exit iz priruc-
nog menija.

U ovoj vezbi pokazali smo kako se biraju bazne tacke koje nisu aktivni ¢vorovi. Videli
ste i kako moZete zadati relativne koordinate za kopiranje ili premestanje aktivnih ¢vo-
rova. Najzad, ako ste ranije izabrali ¢vorove na nekom objektu, pa pritisnuli desni taster
miSa, videli ste da se otvara priru¢ni meni koji pokazuje opcije menjanja pomocu ¢vorova.

Premestanje i rotiranje pomocu ¢vorova

Funkcija Grips nudi jo§ jedan nacin da promenite crtez. Ve¢ znate kako se rastezu krajnje
tacke, ali sa ¢vorovima moZete uraditi i viSe od toga. U sledecoj veZbi naucicete i druge
mogucnosti. Po¢nite tako $to cete ukloniti izmene koje ste uneli u prethodnoj veZbi.

1. Pritisnite alatku Undo s palete Standard ili upi$ite UL Kopije razvucenih linija
nestaju.

2. Pritisnite ponovo 0. Deformisana vrata dobijaju prethodni oblik.

SAVET  Ako pritisnete O u odgovoru na zahtev za unos, nalazete AutoCAD-u da ponovi
poslednju izvrsenu komandu - u ovom slucaju U.

3. Dabiste izabrali cela vrata, postavite kursor u prazan prostor dole i desno od njih,
a zatim pritisnite levi taster misa.

4. Pomerite kursor iznad i levo od pravougaonog dela vrata i pritisnite taster misa.

Posto ste kursor pomerili zdesna nalevo, napravili ste prese¢ni prozor. Setite se da

tako moZete izabrati sve §to je obuhvaceno prozorom i sve preko ¢ega prozor

prelazi.

Izaberite donji levi ¢vor pravougaonika da biste ga aktivirali. Kao i ranije, ugao se

rasteze kada pomerate kursor.

Pritisnite desni taster mi$a, a zatim u priru¢nom meniju za menjanje ¢vorova iza-

berite opciju Move. U komandnom prozoru pokazuje se sledece:

**MOVE**

<Move to point>/Base point/Copy/Undo/eXit:
(<Pomeriti u tacku>/bazna tacka/kopiranje/poni$tavanje/izlaz)

o

e

Sada, kako pomerate kursor, tako se pomeraju i cela vrata.
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N

Postavite vrata blizu centra ekrana i pritisnite taster misa. Vrata se pomeraju u
centar ekrana. Ponovo se pojavljuje zahtev za unos, a vrata ostaju izabrana, $to
znaci da moZete preci na sledecu operaciju.

Izaberite ponovo donji levi ¢vor, pritisnite desni taster misa i iz priru¢nog menija
izaberite opciju Rotate. U komandnom prozoru pojavljuje se:

&

**ROTATE** <Rotation angle>/Base point/Copy/Undo/Reference/eXit:
(<ugao rotacije>/bazna tacka/kopiranje/poni$tavanje/referentni
pravac/izlaz)

Kada pomerate kursor, vrata rotiraju oko tacke koja se nalazi na izabranom ¢voru.

Postavite kursor tako da se vrata rotiraju otprilike za 180 stepeni (slika 2.19).
Zatim, drZeci taster Shift, pritisnite taster misa kojim birate. Pojavljuje se kopija
vrata, a originalna vrata ostaju na mestu.

Pritisnite 0 da biste zavr3ili rad u reZimu za menjanje pomocu ¢vorova.

©

10

SLIKA 2.19 5
Rotiranje i kopi-
ranje vrata

pomocu aktivnih
¢vorova. Vise .
objekata se menja

pomocu ¢vorova

iako je aktivan

samo jedan ¢vor.

SAVET  Videli ste kako se komanda Move drukcije ponasa kada se koristi uz primenu aktiv-
nih cvorova. I ostale komande za rad sa aktivnim cvorovima (Stretch, Rotate, Scale i Mirror)
imaju odgovarajuce komande u standardnom skupu AutoCAD-ovih komandi. U poglavljima
91 13 saznacete kako one rade.

Kada zavrsite bilo koju operaciju sa aktivnim ¢vorovima, objekti i dalje ostaju izabrani,
a ¢vorovi su im i dalje aktivni. Da biste ponistili izbor ¢vorova, pritisnite taster Esc.

U ovoj vezbi videli ste da se komande za aktivne ¢vorove pojavljuju u priru¢nom
meniju. Jo§ neke opcije dostupne su iz ovog menija, ukljuc¢ujuci Exit, Base Point, Copy
i Undo. Osobine objekata moZete menjati i koristeci opciju Properties.

Mnoge od ovih opcija za menjanje ¢vorova moZete izabrati i ako pritisnete razmak-
nicu ili taster Okada je ¢vor izabran. Svaki put kada pritisnete neki od tih tastera, aktivira
se sledeca opcija. Opcije se ponavljaju sve dok pritiskate (1. Taster Shift se ponasa kao
precica za komandu Copy. Upotrebite ga samo jedanput i svaki sledeci put kada izabe-
rete tacku pritiskajuci taster misa, pravi se kopija.
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KRATAK PREGLED MOGUCNOSTI FUNKCIJE GRIPS
U vezbama u ovom poglavlju radite sa samo nekoliko opcija funkcije Grips. U poglavljima koja
slede radicete i sa ostalim komandama za aktivne ¢vorove. Zasad dajem pregled mogucnosti
funkcije Grips.
u Kad izaberete ¢vorove krajnjih tacaka, rasteZete krajnje tacke.
u Ako izaberete ¢vorove srednje tacke, premestate celu liniju.
u Ukoliko se krajevi dva objekta spajaju a vi misem izaberete preklopljene ¢vorove, birate
oba ¢vora u isto vreme.
u Da biste izabrali viSe ¢vorova drZite taster Shift dok miSem birate odgovarajuce cvorove.
u Kada su ¢vorovi aktivni, na raspolaganju su opcije Stretch, Move, Rotate, Scale i Mir-
ror. Aktivirate ih tako Sto pritisnete desni taster misa.
u MozZete ciklicno birati opcije Stretch, Move, Rotate, Scale i Mirror tako Sto cete priti-
snuti taster O kada su ¢vorovi aktivni.
u Sve opcije za aktivne ¢vorove omogucavaju da pravite kopije izabranih objekata, bilo
da birate opciju Copy ili da drZite taster Shift dok birate tacke.
u Sve opcije za aktivne ¢vorove omogucavaju da birate baznu tacku nezavisno od prvog
izabranog aktivnog ¢vora.

Pomo¢ tokom rada
MozZda Cete se dvoumiti oko AutoCAD-ovih funkcija a priru¢nik vam nece biti pri ruci.
AutoCAD ima ugradenu pomoc¢ (Help) koja sadrzi podatke o temi koja vas zanima. Evo
kako da pronadete pomoc:

1. Izaberite Help > Help s linije menija. Pojavljuje se prozor AutoCAD 2004 Help.

2. Izaberite karticu Contents ako vec nije izabrana. Ova kartica pokazuje sadrzaj.
Postoje jos Cetiri kartice oznacene sa Index, Search, Favorites i Ask Me koje
pomaZu da pronadete odredene teme.

SAVET  AutoCAD-ov prozor Help otvarate i tako $to pritisnete taster F1.
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Pomerajte sadrZaj ekrana dok ne ugledate stavku Command References dvaput
pritisnite taster mi$a. Oba okvira Help Window menjaju se i prikazuju viSe tema.
Na desnom okviru pritisnite tasterom misa stavku C s desne strane liste Com-
mands. Okvir se prosiruje i pokazuje listu imena komandi koja pocinju sa C.
Pomerajte se niz listu i izaberite re¢ Copy. Pojavice se detaljan opis komande Copy
u okviru na desnoj strani.

Izaberite stavku Display All Hidden Text On This Page. Prosirice se okvir u kome
su detaljniji podaci o komandi Copy. Taj proSireni prikaz moZzete zatvoriti ako,
pomerajudi se nadole, izaberete Collapse All Hidden Text On This Page.

w

L

5

&

Na vrhu desnog panoa nalaze se i kartice Concepts, Procedures i Reference. Te opcije
sadrze detaljnije podatke o izabranim stavkama. Ako hodete da se vratite na neki od
koraka koji ste upravo obavili, pritisnite dugme Back na paleti alatki.

Upotreba kartice Search
Kada traZite obavestenja o nekoj temi na osnovu klju¢ne reci (engl. keyword), moZete
upotrebiti karticu Search iz okvira za dijalog Help.

1. Izaberite karticu Search koja se nalazi u levom okviru prozora Help. Ako prvi put
birate ovu karticu, videcete poruku kojom AutoCAD saopstava da aktivira indeks
za pretraZivanje.

2. Upisite re¢ Change u polje na vrhu kartice Search, a zatim pritisnite List Topics ili
0. U okviru se prikazuje spisak svih stavki u sistemu Help koje sadrze re¢ Change.
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Ova lista je prenatrpana. MoZete upotrebiti logicke operacije AND, OR, NEAR i NOT
sa ostalim klju¢nim re¢ima da biste u pretraZivanju primenili filtre, kao kad koristite
obican pretraZiva¢ Weba. Kada nadete temu, izaberite je s liste Select topic i pritisnite
dugme Display da biste u okviru na desnoj strani dobili obaveStenja o temi.
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Kartica Ask Me je jos$ jedna alatka u okviru za dijalog Help koja ¢e vas zanimati. Ona
dozvoljava da postavljate pitanja ,svakodnevnim (engleskim) jezikom®. Pratite sledece
korake da biste videli kako radi opcija Ask Me.

1. Izaberite karticu Ask Me (pitaj me).

2. Upisite How do I zoom into my view na vrhu okvira za unos$enje teksta. Spisak
ispod polja za unosenje teksta menja se i prikazuje nekoliko stavki koje se odnose
na podesavanje prikaza u AutoCAD-u.

3. Izaberite stavku pod naslovom Magnify A View (Zoom). Desni okvir se menja i
prikazuje kako radi komanda Zoom.
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Desno od svake stavke u listi kartice Ask Me nalazi se troslovni akronim. Na taj nacin
vas program obavestava o nazivu izvornog dokumenta za svaku opciju s liste. Na primer,
stavka Magnify A View (Zoom) nalazi se u knjizi AutoCAD User’s Guide (Uputstvo za kori-
snike AutoCAD-a) — skradenica je AUG. Uz druge stavke prikazano je ACR, $to je skrace-
nica od AutoCAD Command Reference (Komande u AutoCAD-u). Pretrazivanje moZete
ograniciti i na odredene izvorne dokumente tako $to izvorni dokument izaberete iz
padajuce liste List of components to search.

Ako se pomerate ka dnu liste Ask Me, naci cete opciju Search The Web For:. Ukoliko
ne nadete zadovoljavajuci odgovor u sistemu pomoc¢i AutoCAD-a, moZete izabrati ovu
opciju da biste zapoceli pretrazivanje Web stranice u okviru na desnoj strani. Ako kori-
stite ovu opciju, morate biti povezani s Internetom.

Kartica Index omogucava da nadete odredene teme u sistemu pomoc¢i AutoCAD-a
tako §to Cete upisivati reci u polje List of components to search. Kartica Favorites omo-
gucava da upamtite lokacije sistema pomoci koje Cesto posecujete.
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Koriscenje pomoci za tekuci kontekst
AutoCAD ima i pomo¢ u vezi s tekuéim kontekstom. Ona vas vodi do tema koje se
odnose na aktivhu komandu. Da biste videli kako to funkcioniSe, uradite sledece:

1. Zatvorite ili smanjite prozor Help i vratite se u prozor AutoCAD.
2. Pritisnite alatku Move s palete Modify da biste pokrenuli komandu Move.

3. Pritisnite taster F1 ili izaberite Help s linije menija. Otvara se prozor Help i prika-
zuje opis komande Move u okviru s desne strane.
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4. Pritisnite dugme Close ili taster Esc.
5. Pritisnite taster Esc da biste izasli iz komande Move.

Ako poznajete osnove AutoCAD-a, verovatno Cete Zeleti da instalirate AutoCAD Lear-
ning Assistant (pomo¢ pri ucenju). Ta alatka nudi kratke savete i uputstva za mnoge
teme, ukljucujucii timski rad i maksimalno iskori§¢enje Windowsovog okruZenja. Lear-
ning Assistant se nalazi na CD-u koji je deo paketa AutoCAD 2004.

Dodatni izvori za trazenje pomoci

Alatka Help Topics je vodeci izvor referentnog materijala, ali odgovore na pitanja
moZete pronaci i u meniju Help. Sledi kratak opis opcija menija Help:

Active Assistance Prozor koji nudi trenutni odziv na zadatu komandu. U verziji LT,
prozor Active Assistance se otvara podrazumevano. Ova opcija moZe da bude korisna
za pocetnike, ali nekim korisnicima smeta. Da biste je iskljucili, pritisnite desnim
tasterom misa ikonicu Active Assistance s palete sistemskih poslova Windowsa (iko-
nica sa znakom pitanja), a zatim iz priru¢nog menija izaberite Exit. MoZete podesiti
da se prozor Active Assistance pojavi samo onda kada se pozove iz menija Help. Priti-
snite desnim tasterom misSa ikonicu Active Assistance na paleti sistemskih poslova i
izaberite Settings iz priru¢nog menija. Otvorice se okvir za dijalog Active Assistance.
Izaberite opciju On Demand i pritisnite OK.
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Developer Help Posebni podaci namenjeni osobama koje rade na razvoju pro-
grama. To obuhvata i osobe koji se bave prilagodavanjem AutoCAD-a.

New Features Workshop Lekcije i opisi novih mogucnosti u AutoCDAD-u 2004. Ovu
alatku moZzete azurirati preko Autodeskove Web prezentacije.

Online Resources Nudi dodatne opcije koje pokrecu vas ¢itac Web-a i $alje vas na
Autodeskovu Web lokaciju PointA. Preko ovih opcija moZete pronaci najsveZije infor-
macije o podr3cii obuci za rad u AutoCAD-u.

About Podaci o verziji AutoCAD-a koju koristite.

Informisite se preko centra za komunikaciju

Funkcija centar za komunikaciju (engl. Communication Center) omogucava da budete
u toku sa svim novinama u AutoCAD-u. Na kraju desne strane statusne trake, videcete
ikonicu Communication Center, kao i poruku u oblaciéu koja pokazuje na nju.
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Pritisnite dugme Settings. Otvorice se okvir za dijalog Configuration Settings.

U oblasti Country mozZete izabrati svoju zemlju s padajuce liste Country, da biste bili
sigurni da informacija vazi za vasu zemlju. Opcija Check for New Content omogucava
da izaberete ucestalost kojom ce centar za komunikaciju proveravati da li ima novih
informacija. MoZete izabrati jednu od opcija: Daily, Weekly, Monthly ili On Demand
(dnevno, nedeljno, mesecno ili na zahtev). Ako Zelite da iskljucite prikazivanje poruke
u oblacicu koja ukazuje na ikonicu Communication Center na statusnoj traci, iskljucite
polje za potvrdu Enable Balloon Notification for new announcements na dnu okvira za
dijalog.
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Kada prvi put izaberete zemlju, videcete dugme Refresh Content levo od dugmeta Set-
tings u okviru za dijalog Communication Center. Ako ste prikljuceni na Internet, mozete u
bilo koje vreme pritisnuti ovo dugme i tako proveriti da li ima informacija. Ako postoji bilo
kakva nova informacija, pojavice se upozoravajuca poruka u okviru za dijalog.

Communication Center radi najbolje ako koristite stalnu vezu sa Internetom kao $to
je DSL ili veoma brzu kablovsku vezu. Ukoliko nemate ovakve mogucénosti, moZete
podesiti opciju Check For New Contents na On Demand. Tako ¢ete proveravati da li ima
nekih novosti kada ste prikljuceni na Internet.

Prikazivanje podataka u prozoru Text

Radeci u AutoCAD-u mogli ste da pratite poruke prikazane u prozoru Command. Pone-
kad je korisno pogledati informacije koje su pomerene iz vidljivog dela komandnog pro-
zora. Na primer, moZete pregledati aktivnosti s komandama u svojoj prethodnoj sesiji
da biste proverili ulazne vrednosti ili neke druge unete podatke. Uradite sledec¢u veZzbu
da biste saznali kako radi prozor Text.

1. Izaberite Tools > Inquiry > List.

2. Nazahtevza unos Select objects:izaberite jedan od lukovai pritisnite [l.
U AutoCAD-ovom prozoru Text (slika 2.20) prikazuju se informacije o ltiku. Pri dnu
se nalazi spisak osobina ltika. Ne brinite ako ne razumete svaku osobinu sa ove
liste. Tokom rada uz knjigu, naucicete §ta znace razlicite osobine nekog elementa.

3. Pritisnite taster F2. AutoCAD-ov prozor Text se zatvara.

SAVET  Pomocu funkcijskog tastera F2 brzo prelazite iz editora za crtanje u prozor Text
i obrnuto.

Traka za pomeranje koja se nalazi desno od prozora Text vodi vas do nekih ranijih
dogadaja. MoZete podesiti ¢ak i broj redova koje ¢e AutoCAD zadrzati u ovom tek-
stualnom prozoru koristeci okvir za dijalog Options. Uz to, AutoCAD moZe da
snimi informacije iz prozora Text u obliku tekstualne datoteke.
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Kada je vise dokumenata otvoreno u isto vreme, prozor Text ¢e prikazati listu trenu-
tno aktivnog crteza.

Prikazivanje osobina objekta

Dok razmatramo prikazivanje informacija, upoznacete se i s paletom Properties. U
poslednjoj vezbi videli ste da je komanda List prikazivala neke informacije o osobinama
objekta, kao $to je mesto na kome se nalaze centar i krajnje tacke ltka. Osim toga,
moZete dvaput pritisnuti objekat da biste prikazali paletu Properties koja sadrZi slicne
informacije. (U stvari, ponekad i slu¢ajno aktivirate paletu Properties.) Da biste saznali
¢emu sluzi ta paleta, uradite sledecu vezbu.

1. Dvaput pritisnite lik u crteZu. Otvorice se paleta Properties u kojoj je prikazan
spisak osobina tog ltka.
Ne brinite ako ne moZete rastumaciti mnoge stavke u ovoj paleti. Naucicete viSe o
njoj tokom veZbanja u prvih nekoliko poglavlja ove knjige. Zasad se uverite da se
ova paleta pojavljuje svaki put kada dvaput pritisnete misem neki objekat i da su
u njoj prikazane osobine objekta.

2. Pritisnite malo polje Auto-Hide koje se nalazi na dnu palete Properties, sleva. To je
sli¢ica dvostruke strelice. Postace jedna strelica.

" Frol i rimEn

3. Udaljite kursor od palete Properties. Ona ¢e nestati i ostace samo naslovna traka.

4. Postavite kursor na ovu naslovnu traku. Otvorice se paleta Properties i ponovo
prikazati sve opcije.
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Opcija Auto-Hide omogucava da paleta bude prikazana, a da ne oduzima mnogo od
povrsine za crtanje. Ovo moZe biti korisno pri podesavanju osobina mnogih objekata.
1. Pritisnite ponovo polje Auto-Hide da biste ukljucili stalan prikaz palete.

2. Zatvorite paletu Properties tako §to Cete pritisnuti X u gornjem levom uglu.
Takode moZete pritisnuti desnim tasterom miSa naslov na levoj strani palete
Properties i izabrati sa Close iz priru¢nog menija.

3. Posto ste zavrsili crtez vrata, izaberite File > Close.

4. U okviru za dijalog Save Changes izaberite dugme No. (Ranije ste snimili ovu
datoteku, pa sada ne morate ponovo da je snimate.)

SAVET  Paleta Properties moze se otvoriti i ako izaberete objekat, a zatim pritisnete desni
taster misa i s menija koji se pojavi izaberete Properties.

Ako zelite da eksperimentisete...

Treba da nacrtate rezu sa slike 2.21.

1. Pokrenite AutoCAD, otvorite novu datoteku i nazovite je Reza.

2. Iz grafickog editora izaberite komandu Line da biste nacrtali prave delove reze.
Pocnite liniju kako je pokazano na slici, zatim zadajte relativne koordinate preko
tastature. Na primer, za prvi segment linije upiSite @4<1800C da biste nacrtali seg-
ment duZine 4 jedinice, zdesna nalevo.

3. Izaberite alatku Arc s palete Draw. Nacrtajte 1tk za zakrivljeni deo.

4. Upotrebite opciju Endpoint Osnap i izaberite krajnju tac¢ku prikazanu na slici da
biste zapoceli lik.

5. Upisite E0 da biste izabrali opciju End komande Arc.
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6. Ponovo upotrebite Endpoint Osnap i izaberite krajnju tacku iznad mesta na kome
ste zapoceli crtanje linije. Pojavljuje se rastegljiva linija i privremeni lak.

7. Upisite DO da biste zadali opciju Direction komande Arc.

8. Postavite kursor tako da istaknuti Itk izgleda kao na slici 2.21. Pritisnite taster
misa i nacrtajte ltk.

SLIKA 2.21 Ovde zapocnite crtanje linije
Pokusajte da
nacrtate rezu.
Dimenzije su
zadate.

4.0

Ovde zapocnite crtanje lika
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